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Trademarks

Microsoft is a U.S. registered trademark of Microsoft
Corporation.

Windows and MS-DOS are trademarks of Microsoft Corporation.

IBM, PC, AT, XT are registered trademarks of International
Business Machines Corp.

Other brands and product names herein are trademarks or
registered trademarks of their respective holders.

Copyright

All rights reserved. No part of this publication may be reproduced,
transmitted, transcribed, stored in a retrieval system, or translated
into any language or computer language, in any form or by any
means, electronic, mechanical, magnetic, optical, chemical,
manual, or otherwise, without the prior written permission of
Avision Inc.

Material scanned by this product may be protected by
governmental laws and other regulations, such as copyright laws,
the customer is solely responsible for complying with all such
laws and regulations.
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Warranty
The information contained in this document is subject to change
without notice.

Avision makes no warranty of any kind with regard to this
material, including, but not limited to, the implied warranties of
fitness for a particular purpose.

Avision shall not be liable for errors contained herein or for
incidental or consequential damages in connection with the
furnishing, performance, or use of this material.
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FCC Radio Frequency Interference Statement

This equipment has been tested and found to comply with the
limits for a class B digital device, pursuant to Part 15 of the FCC
rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio
communication. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of
the following measures:

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.
* Connect the equipment into an outlet on a circuit different from
that to which the receiver is connected.
* Consult the dealer or an experienced radio/TV technician for help.

CAUTION:  Any changes or modifications not expressly
approved by the manufacture of this device could void the user's
authority to operate the equipment.
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1. Introduction

Congratulations on your purchase of Avision
AV6240 1-pass color flatbed image scanner.  Avision Inc.
is one of the leading companies in the world to develop
high performance image scanners.

Before you install and operate the new scanner, please
take a few minutes to read through the manual.  It
provides you with the proper instructions on how to
unpack, install, operate and maintain the scanner.

Figure 1-1 shows how the scanner is packed, you can
check all the items against your checklist.  If you did not
receive all the items, please contact your authorized local
dealer immediately.
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Figure 1-1 Scanner packing
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2. Scanner Installation

Precautions

* Keep the scanner out of sunlight. Direct exposure to the sun 
or excessive heat may cause damage to the unit.

* Do not install the scanner in a humid or dusty place.
* Be sure to use the proper AC power source.
* Place the scanner securely on an even, flat surface. Tilted or 

uneven surfaces may cause scanning problems.
* Retain the scanner box and packing materials for shipping 

purposes.

2.1 Installation of the Scanner

Please unpack the scanner carefully, and check the contents
against the checklist.  If any items are missing or damaged,
please contact your authorized local dealer immediately.

Remove the shipping retainer:

Stand the scanner on its side as shown in Figure 2-1. (See
Figure 2-1)

Unscrew the retainer screw.

Pull out the shipping retainer, put it in the “use position” slot
next by and there fix it with the screw. (See Figure 2-2)

Put back down the scanner for normal operation.
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Figure 2-1 Remove the shipping retainer.

Figure 2-2 Fix the shipping retainer at the “use position.”



2-3

Refit the shipping retainer:

Please follow the instructions below if you are to transport the
scanner.

1. Turn off the scanner.
2. Open the document cover so that the copyboard glass and

the reading engine comes visible in sight.
3. Turn on the scanner.  At this, the reading engine should

move a few inches forward and stay there for a few seconds.
Turn off the power during this pause.

4. Raise the scanner high enough to unscrew the shipping
retainer from the “use position” and fix it at the “ship
position.”
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2.2 Installation of the SCSI Card

2.2.1 Hardware Installation

The hardware installation of SCSI card is quite simple, just follow the
following procedure:

(1) Power off your computer.
(2) Plug the SCSI card in an available slot of your computer.  Be

sure to screw it firmly.
(3) Power on your computer.

The color image scanner bundled with SCSI card  is designed to
operate with its default setting in most ISA-class PCs.

SCSI ID:
When you have several devices on a SCSI chain, you may need
to adjust the SCSI ID selector setting located on the back of the
scanner.  This setting assigns a specific "device ID" to the
scanner.  If the assignment conflicts with an existing SCSI
device, please select a new ID. (See Figure 2-4)

Note: The factory setting for Avision AV6240 scanner is ID 6.  
Usually, ID 0 is assigned to an internal hard disk drive, 
and ID 7, to SCSI adapter or host.  ID 8 and 9 are not in 
actual use.
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Figure 2-3 Adjust the SCSI ID setting.
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2.2.2 Software Installation

In Windows 3.1
(1) If your scanner is bundled with a SCSI card, then install the

scanner driver will simultaneously complete the installation of  the
SCSI card driver.

(2) If you purchased your SCSI card separately from the scanner,
then please follow the manual provided by your SCSI card
supplier.

In Windows 95
(1) Press Start>Setting>Control Panel.  And then double click "Add

New Hardware" icon.  Select SCSI Adapter.
(2) Select "Have disk" and type "d:\DTCSCSI"(d means the letter for

your current CD-ROM drive)
(3) Press Finish button and restart Windows 95.
In Windows NT
(1) Press Start>Setting>Control Panel.  And then double click "Add

New Hardware" button.  Select SCSI Adapter.
(2) Select Driver tag and Add new SCSI Adapter.
(3) Select Have disk and type "d:\DTCSCSI(d means the letter for

your current CD-ROM drive)
(4) Select Finish and restart Windows NT.

Note:  For more details on how to install the SCSI driver, please refer
to the Appendix or your SCSI card manual if you purchased it
separately from Avision.
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2.3 Document loading
For flatbed scan, see Figure 2-4.

Figure 2-4 Put documents on the scanner.
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2.4 Connecting the Cable

Be sure the scanner power is switched off.

Connect the power cable and signal cable as shown in Figure 2-5.

Turning on the Power

The power is controlled by a toggle switch on the left side of
the scanner.  To turn on the scanner, press the switch toward
"1."  At this, the POWER LED should light on.  If not, please
check the power.

Figure 2-5 AV6240 cable connection
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Connecting the SCSI cable to the scanner

If the scanner is the only (or final) SCSI device connected to
your host computer, you have to plug the Regular End
Terminator into the unused SCSI connector on the scanner (See
Figure 2-6).  The scanner will not function properly unless
every SCSI connector is either connected or terminated.

If the scanner is linked in a SCSI chain (between the host
computer and other devices), plug the SCSI cable from other
devices into the unused SCSI connector of the scanner (See
Figure 2-7).
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Single -Device Configuration

Figure 2-6  In the single-device configuration, the SCSI connection
terminates at the scanner.

SCSI Chain Configuration

Figure 2-7  In the SCSI chain configuration, the scanner is connected
to the host computer;  a second SCSI cable then connects
the scanner with other devices, such as a printer.
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Scanner Diagnostics

The scanner has a built-in self-diagnostic function to detect system
errors.  The self-test is initiated each time the scanner is turned on.
During the test, the READY LED and ERROR LED will light on.  At
the end of the test, if no error occurs, the READY LED should stay
solid while the ERROR LED should extinguish.  If the ERROR LED
goes on blinking after the diagnostic test, please consult your local
dealer to resolve the problem.
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3. Scanner Driver Installation

To run AV6240 1-pass color scanner at rated speed, the
following minimum requirements are recommended.

* IBM compatible PC 486, Pentium, or higher;
* Microsoft Windows 3.1 or Windows 95 or Windows NT;
* DOS 5.0 or higher;
* 20 megabytes of available hard disk space;
* 8 megabytes of RAM (16 megabytes or higher

recommended);
* A video graphics array (VGA) monitor;
* A Microsoft Windows-compatible pointing device (e.g.,
 mouse);

* A CD-ROM drive.

3.1 Auto-Installation Program

The installation procedures of Avision scanner driver with
Avision Auto-Installation Program are as follows:

1. Start Windows 3.1 or Windows 95 or Windows NT.
2. Insert Avision PaperCom Supreme CD into your CD-ROM
drive.

In Windows 3.1 or Windows 3.11

3. From the File Menu, choose RUN, type
d:\driver\AV6240.exe (d: the drive in use), and then click
OK.
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For Windows 95 or Windows NT4.0  (See Figure 3-1,3-2)

3. Press the Start button, choose RUN, type type
d:\driver\AV6240.exe (d: the drive in use), and then click
OK.

4.   Follow the instructions on the screen to complete the 
installation (usually just clicking OK will complete the 
installation).

Fig. 3-1

Fig. 3-2
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4. Scanner Operation & Document Printing

TWAIN is the most popular interface among image-editing
application software.

Scanning Images from within an Application (TWAIN)

Open your application and choose Select Source from the
File menu.  If the Select Source menu options are not
available from the File menu, see the user guide of your
application to learn how the TWAIN link is used.

A dialog box appears containing the different TWAIN
sources that you can choose for bringing an image into
your application.

Select MrScan/32-Expert Vx.xx as the source.

You need to select Mrscan/32-Expert Vx.xx for just once
except when you have used the dialog box to select a
different source.  In that case, you will need to select
Mrscan/32-Expert Vx.xx as the source again before you
can resume your use of AV6240 scanner. Place the image
to be scanned face down on the scanner.

From the File menu, select Acquire.

AV6240 TWAIN user interface will pop up on the screen.
Click on the Prescan or Scan button to get the image.
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Avision TWAIN user interface
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4.1 Scanning Source:

AV624 scans two types of original source, the document as well as the
transparency.  Select either one from the Source drop-down list box as
shown in the following Figure.

Note:  To make transparency scanning work, you have to purchase the
transparency unit separately.  You can consult the details from your
nearest dealer.
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4.2 Image Type

You can select the Type menu for the mode you want to use with
your document or image.

   

Line art
Line art includes only black and white areas.
There are no intermediate shades of gray in
between.

Halftone
In addition to the black and white display,
Halftone can create the illusion of shades of gray
by using different size of dots.
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Gray (256 levels gray scale)
Scanner recognizes each point in the image as a
shade of gray (continuous tone).  8-bit gray gives
more detailed information about the image.

256 Color

256 Color presents 256 colors in a color image.

True Color (16.7 million colors)
Color image have continuous tones along with its
color hues.
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4.3 Resolution Control

Resolution: A good control of the resolution results a
satisfactory detail of an image.  The resolution is measured by
dots per inch(dpi).  Normally the greater the dpi number, the
higher the resolution and the image file size.  Yet the greater
resolution takes more time, memory and disk space,
therefore, up to a certain degree of dpi, the resolution will
not visually be improved, on the contrary, it makes your files
more unmanageable.                      
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4.4 Image Control

Brightness: Adjusts the lightness or darkness of an image.  The
higher the value, the brighter the image.

Contrast: Adjusts the range between the darkest and the
lightest shades in the image.  The higher the
contrast, the bigger the different gray scales.

Gamma: Adjusts the midtone of the image without losing
details of the lightest and the darkest areas.

Highlight: Adjusts the highlight area of the image.

Shadow: Adjusts the darkest area of the image.

Brightness

Contrast

Gamma

Highlight

Shadow

Hue

Intensity

Saturation
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Hue: Adjust the hue up to 360 by clicking your desired
color on the Color wheel or clicking the up or
down arrow button.  (Note the level of intensity
will be changed simultaneously when the hue
adjustment is made.)

Intensity: Adjust the color strength by clicking the up or
down arrow button.

Saturation: Adjust the saturation level for the color by clicking
the up or down arrow button.  The level of
saturation decides if the color is pale or rich.

Auto Level Automatically adjusts the highlight and shadow areas
of the scanned image to give it an optimal effect.

       

Invert:                  The invert command reverses the brightness and the
color in the image.  For color images, each pixel will
be changed into its complementary color at the
command of Invert.

       

Color Matching:  Adjusts the color quality of the image so that it

Currently
disabled
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comes close to that of the original.  This function
uses default parameters to adjust the image.

           

Sharpen: Sharpens the scanned image.  Look for more
selections under this item.
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Descreen: Eliminates the moire patterns commonly found in 
printed matter.

                   
                       Before Descreen                         After Descreen
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4.5 Scanning

Preview: Previews your image roughly and allocates the area
to be scanned.

Scan:  Scans the area with the parameters you have set.
Exit: Cancel the current job.

As shown in the figure below, in the Preview window, you can
define the area to be scanned by dragging the cursor auxiliary
lines with the mouse.

                      

Click here to shift between different measure systems

The cursor auxiliary lines

The Preview
Window
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5. Maintenance

5.1 Cleaning the Copyboard Glass
Your scanner is designed to be maintenance free.  However, it
still needs to be cleaned from time to time to ensure optimum
image quality and performance.

The scanner document glass may be contaminated with ink, toner
particles or paper coatings.  As a result, the scanner needs to be
cleaned occasionally particularly if the scanned image looks
smeared.

The cleaning procedures (See Figure 5-1)

  1) Open the document cover.
  2) Soak a cotton swab with some isopropyl alcohol. (95%).
  3) Wipe the copyboard glass by moving the swab from side to

side.  Repeat this step until the whole copyboard glass is
cleaned.

  4) Close the document cover.  Your scanner is now ready for 
use.
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Fig. 5-1 Cleaning the document glass

The Document
Glass
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6. Troubleshooting
The scanner will automatically perform a simple self-test
each time it is turned on.  This helps spot major system
errors in the scanner itself.

During the test, the READY LED and ERROR LED will light
on and the scanner reading head will move a bit forward.
Once the test is finished and if no error occurred, the READY
LED will stay solid and the ERROR LED will extinguish and
the scanner reading head will back to its leftmost position.

If you have problem with the operation of your scanner,
please check the following troubleshooting hints.
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6.1 Questions and Answers

Question: The LED indicates that the scanner is ready, but
the scanner does not act to the Scan command
from the host computer.

Answer:  Please check that the signal cable is firmly seated,
and invoke the Scan command again.  If there is
still no response, please reboot the host computer
as well as reset the scanner by turning it off and
then on again.

Question: When the scanner is powered on, it makes noises 
and won’t stand ready.

Answer:  There are two possibilities:
1) You forgot to remove the shipping retainer 

from the scanner.  If this is the case, please 
remove the shipping retainer first.

2) The scanner is not placed on an even, flat 
desktop surface.  This may cause the scanner
to function improperly.

Question: The scanner is powered on, but the lamp does not
 light on.

Answer: The possible causes are as follows:
1) The lamp is out of order.  In this case,

contact your local dealer or distributor to
change the lamp.  The average life time of the 
lamp is about 50,000 hours.

2) The fuse on the main board of the scanner is 
burned.  You can check the main board of the 
scanner.  If the fuse is burned, replace it with a 
new fuse that is 250V/2A .
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3) If the fuse is burned again after the changing, 
it means the invertor of the lamp is burned.
Call your local dealer or distributor to replace 
the invertor.

Question: To get image from the scanner is no problem.  But
when scanning, the scanner or the system will often 
crash.

Answer: 1) Please check that the cable is firmly seated.
2) Only two SCSI terminators can be connected

to your SCSI daisy chain.  One is at the end of
the SCSI device, the other already in your host
adapter. (Please see Section 2-2 for more 
details.)

Question: Scanning, the scanner will often make noises, or it
scans back and forth.

Answer:  Please select a lower speed from the TWAIN
 user interface for low-speed PC.

Question: Why is it the scanned images always come out to
be too dark.

Answer: 1) Modify the Gamma setting to1.8 for your 
monitor and, when printing, set the Gamma 
setting to 2.2 for your printer.

2) Adjust the Brightness setting from the TWAIN 
user interface to get a brighter image.

Question: The scanner works well otherwise but for the 
line art, of which the lines seem to be much 
thicker than those of the original.

Answer: Use the Brightness or Threshold setting to
control the line art image.
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6.2 Technical Service

Technical support for Avision scanner is provided at the
Avision Technical Assistance Center (ATAC).  Before
contact with ATAC, please prepare the following
information:

* Scanner serial & revision number (located on the bottom 
of the scanner);

* Hardware configuration (e.g., your host CPU type, RAM
size, free disk space, display card, interface card...);

* The name and version of your scanning software 
application;

* The version of your scanner driver.

Please call us at:

US and Canada Area:
Avision Labs., Inc.
Address                  :6049 Stewart Ave., Fremont, CA 94538
Telephone number :510-440-8785
Fax number  :510-440-8337
Web Site  :http://www.avision.com
E-mail  :avision@avision-labs.com

Other Area:
Avision Inc.
Address                  :No.20, Creation Road, Science-Based

Industrial Park, Hsinchu, Taiwan, R.O.C.
Telephone number :886-3-5782388
Fax number :886-3-5777017
Email :service@avision.com.tw
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Note: You can find the latest driver and documents
in our homepage located in World Wide
Web(WWW) with  our web site:
http://www.avision.com
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7. Specifications
All specifications are subject to change without notice.

7.1 Model: AV6240

Scanner Type: 1-pass 30-bit color flatbed

Optical Resolution: 600 dpi * 1200 dpi (H*V)

Max Resolotion: 19200 dpi * 19200 dpi

Scanning modes: Black & White mode
Halftone mode (64-step)
8-bit Gray scale (256 levels)
24-bit color (16.7 Millions of color)
(30-bit internal, auto mapping to optimal 24-bit)

Document size: 216 x 356 mm (8.5 x 14 inches)

Interface: SCSI 2

Power Source: 100-240 VAC, 50-60 Hz
Power Consumption:35 watts

Dimensions:  570 mm x 350 mm x 117 mm (WxHxD)
Weight: Approx. 20 lbs. (9 kg)
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EC Declaration of Conformity

According to EN45014
Manufacturer's Name: AVISION INC.
Manufacturer's Address: No. 20, Creation

Rd. I, Science-Based
Industrial-Park,
Hsinchu, Taiwan,
R.O.C.

declare that the product

Model Number : AV6240

conforms to the following Product Specifications:

Emission: EN 50081-1(1992)
EN 55022(class B)
(Conducted  Radiated) (1994)
EN 60555-2 (Harmonics) (1987)
EN 60555-3 (Flicker) (1987)

Immunity:
EN50082-1(1992)
IEC 1000-4-2 (ESD)(1995)
IEC 1000-4-3(RS)(1995)
IEC 1000-4-4(EFT/Burst)(1995)
IEC 1000-4-5(SURGE)(1995)

Date: December, 1995
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Appendix  Detailed Procedure for
installing SCSI Driver

 
Continue on subsection 2.2.2 Installation of the SCSI Card,

In Windows 95, please:
(4) The "New Hardware Found?" dialog box will be displayed.

Choose Driver from hard disk provided by the hardware
manufacturer or choose Do not install a driver.

 
 If you choose Driver from hard disk provided by the

hardware manufacturer, please follow the following
procedure.

 
(5) The "Install from hard disk provided by the hardware

manufacturer" dialog box will be displayed. Press Browse button
to assign your path.  Type d:\DTCSCSI (d is the letter indicating
your current CD-ROM drive).  Press OK.

(6) The unknown device statement will be displayed.  Press OK.
(7) The d:\SCSI  and filename will be displayed.  Press OK.  Your

are now completing the installation of SCSI card on your
computer.

 
 If you choose Do not install a driver, please follow the

following procedure.
(5)  Click Windows Start icon from the bottom.  Choose Setting.

Choose Control Panel from Setting.
(6)  Double click "Add new hardware" icon from the Control Panel.

The "Add new hardware wizard" dialog box will be displayed.
Choose Next.

(7)  The "Do you want Windows to search for your hardware" dialog
box will be displayed.  Press No and then press Next.

(8)  Choose hardware type "SCSI Controller", then press Next.
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(9)  The "click the manufacturer & model of your hardware" dialog
box  will be displayed.  Choose current SCSI manufacturer and
model and then press Next.  Follow the subsequent procedure as
indicated to complete the installation and to restart Windows 95.

(10)  If current manufacturer and model are not listed in the selection
box, press Have disk button. The "Have disk" dialog box will be
displayed.  Type d:\DTCSCSI in the path box(d is the letter
indicating your current CD-ROM drive).  Choose Confirm and
follow the subsequent procedure as indicated on the screen to
complete the installation.

(11)  The "Finish" dialog box will be displayed.  Choose Finish and
then choose Restart the Windows 95.

In Windows 3.1, please:
(4)  If your SCSI card is bundled with Avision AV260CS, then install

the scanner driver will simultaneously install the SCSI card driver.
(5)  If your SCSI card is not bundled with Avision AV260CS, then

please follow the installation sheet contained in your SCSI card.

In Windows NT, please:
(5) Click Windows Start icon from the bottom.  Choose Setting.

Choose Control Panel from Setting.
(6) Choose SCSI Adapter from the Control Panel.  The " SCSI

Adapter" dialog box will be displayed.  Choose Driver.
(7) Choose Add and select manufacturer and SCSI adapter
(8) Choose Have disk if your SCSI card manufacturer and SCSI

adapter is not listed in the selection box.  Type d:\DTCSCSI (d
representing the letter of your current CD-ROM drive) and choose
Confirm.

(9) Follow the subsequent procedure on the screen to complete the
installation.

When the "System Setting Change" dialog box appears, choose OK to
restart Windows NT.


